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RELEASE NOTES - AVIZO 9.0, JANUARY 2015  

Avizo 9.0 

3D Analysis Software for Scientific and Industrial Data 
 

Dear Avizo User, 

With this document we would like to inform you about the most important new features, 
improvements, and changes in this version. Please read these Release Notes carefully. 
We would appreciate your feedback regarding this version. If you encounter problems, but also if you 
have suggestions for improvement, please report them to vsghotline@fei.com. 
We would like to thank you in advance for your efforts. 

January 2015, the Avizo and Amira team 
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OVERVIEW 

Avizo 9.0 is a major evolution of the Avizo product family including new extensions, enhancements of the user 

interface for ease of use and simplified workflows, new and enhanced features, and performance improvements. 

 

 
Important note: the Avizo product family evolves!  
 
The Avizo product family is aimed primarily at providing software tools to scientists for characterizing material 
structures and properties. Thus, the previously named Avizo Fire edition has become the most widely used version, 
and more specifically its image processing, analysis and quantification modules, which are an essential part of Avizo’s 
feature-set for materials characterization. 
 
In order to present more clearly Avizo as the reference software for visualization, analysis, and quantification in 
Materials Science and Industrial Inspection, Avizo Fire edition will be just named Avizo. 
 
Avizo Standard edition is now called Avizo Lite as it does not include Avizo complete features set, and hence offers 
more limited capabilities. Avizo Lite version 9 and later will provide exactly the same level of capabilities as the 
previous Avizo Standard edition, extended by the enhancements and new features introduced by version 9 and 
further evolutions, but excluding Avizo advanced image processing, analysis and quantification features, and other 
Avizo extension-specific features. 
 
The previous Avizo editions targeting more specific applications are now Avizo extensions, providing specialized 
features for CAE post-processing, environmental and geophysics data visualization, and analysis.  
  
Avizo Wind edition becomes the XWind extension, available for Avizo Lite and Avizo.  
The XWind extension includes dedicated visualization and computation modules, readers and writers for advanced 
FEA/CFD data processing, and analysis. 
 
Avizo Earth edition becomes the XEarth extension, available for Avizo Lite and Avizo.  
The XEarth extension includes dedicated visualization and computation modules and workflows, as well as a SEG-Y 
reader, for the exploration and analysis of geophysics data.  
 
Avizo Green edition becomes the XGreen extension, available for Avizo Lite and Avizo.  
The XGreen extension includes visualization and computation modules, a set of geographical projections and a NetCDF 
reader, dedicated to the analysis of climate, oceanography, environmental, and earth-mapped data. 
 
 

 

About Avizo and Amira 

Avizo is 3D data visualization and analysis software dedicated to materials science and industrial inspection. Avizo 

originates from the Amira software that was initially created for scientific visualization and life sciences imaging 

applications. Amira and Avizo share the same platform and have many common features. However Amira remains 

focused on medical and biology fields, while Avizo addresses materials and physical sciences as well as industrial 

inspection. 
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NEW XFIBER EXTENSION 

Avizo XFiber is a new extension that provides specific support for analyzing fibers, filaments, tunnels, and other 

networks or tree-like structures. This extension provides automatic, semi-automatic, and interactive tools to assist 

segmentation and analysis process. 

NEW FIBER TRACING FEATURES 

The Avizo XFiber extension introduces two new modules for tube-like structure detection and tracing on various 

modality acquisitions such as X-ray micro-tomography. These modules can be very powerful in a number of cases to 

detect fibers or tube-like structures in noisy or low resolution images. The new modules Cylinder Correlation and Trace 

Correlation Lines are part of the new Fiber Tracing category.  

A dedicated tutorial describes the detection workflow for steel fibers in reinforced concrete. 

NEW CYLINDER CORRELATION MODULE 

This module computes the cross correlation of an input scalar field with a parametric hollow or solid cylinder with 

optional correction for missing wedge artifacts. It can be used to enhance tube-like structures in an image, for 

example cellulose fibers in paper. The module is the first step before tracing the centerlines of these structures with 

the Trace Correlation Lines module. 

NEW TRACE CORRELATION LINES MODULE  

This module traces lines based on a correlation field and an orientation field as computed by the Cylinder Correlation 

module. The output is a Spatial Graph object containing the traced centerlines. To get basic statistics for the 

generated lines, you can use the Spatial Graph Statistics module that has been enhanced to compute also the 

orientation of each centerline. 

 
Steel fiber centerlines extracted from an X-ray micro-tomography scan of reinforced concrete 

 

SKELETONIZATION FEATURES 

The Avizo XFiber extension now includes all of the features of the prior XSkeleton option, which combines specific 

micro-detailed image mosaic management with advanced automatic and semi-automatic tools for reconstruction of a 

3D porous, fracture, vascular, or dendritic networks from volume data. More specifically, the following modules are 

file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/hxspatialgraph/HxSpatialGraphStats.html
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included: Auto Skeleton, Centerline Tree, Thinner, Distance-Ordered Thinner, Trace Lines, Eval On Lines, Radius 

Histogram, Smooth Line Set. 

 

NEW FILAMENT EDITOR 

The Avizo XFiber extension introduces the Filament Editor workroom (see Avizo Lite dedicated paragraph below to 

learn more about the workroom concept).  

The Filament Editor is a well-proven feature of Amira that was initially designed to analyze and quantify 3D images of 

filamentous structures such as neurons and blood vessel networks. The Avizo XFiber extension now brings to Avizo 

users the benefits of the Filament Editor for the study of fiber structures in materials such as reinforced concrete, 

composite materials, paper, and more. 

The Filament Editor offers automatic and interactive tracing tools for segmenting the centerline of the fibers and 

measuring their thickness in fiber networks and other filamentous structures, and editing spatial graphs obtained 

through skeletonization. Automatic tools can be used for images with good object-to-background contrast and will 

quickly deliver analysis results. However images may contain artifacts such as noise and blur, and automatically traced 

images will include false connectivity and/or missing segments. Interactive tracing tools as well as a full-featured line 

editor can then be used to correct possible tracing errors.  

The Filament Editor is activated by pressing the Filament Editor button in the workroom toolbar.  

 

This will change the layout of the main and viewer windows.  

 

 

The main components of this layout are the following: 
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 Data Selector: In the upper part of the main window two drop-down menus allow you to select the image 

and the Spatial Graph data object to be edited.  

 2D Viewer Settings: Controls for window level and thickness settings in 2D slice and 2D segment viewer. It 

also provides buttons to turn on/off volume rendering and/or slicing in the 3D viewer.  

 Label Window: The major part of the main control panel is occupied by the label window presenting a tree-

like representation of the graph. Here the user may define and edit an arbitrary number of labels on different 

hierarchical levels of the graph data. 

 Tool Box: Below the label window a tool box provides access for the tracing tools, the graph display and the 

editing options. 

 Info Area: At the bottom of the control panel a box informs the user about the graph being edited.  

 Viewers: The Filament Editor typically offers three viewers for editing and viewing the data. The 2D slice 

viewer displays the image data as an arbitrarily oriented slice with variable thickness. In contrast the 2D 

segment viewer displays the image data along the currently selected segment as a curved slice with variable 

thickness. The 3D viewer is the regular Avizo viewer for 3D visualization of the graph data with optional 3D 

slice and volume rendering display. 

To learn more about the Filament Editor, please refer to Avizo User’s Guide. 

 

NEW XWIND EXTENSION – ADVANCED CFD/FEA DATA EXTENSION 

Avizo Wind edition becomes the XWind extension, available for Avizo Lite and Avizo.  

The XWind extension includes all features previously available in Avizo Wind edition: dedicated visualization and 

computation modules, readers and writers for advanced FEA/CFD data processing, and analysis. 

Same as previous Avizo Wind edition, the XWind extension requires a specific license. When installing Avizo, a specific 

action is no longer required for installing the XWind extension: you simply have to enter the appropriate activation 

code in the License Manager dialog. 

XWind tree view is available from the Project View shortcuts menu: 

 

The standard behavior of the tree view in Avizo Wind that consists of organizing display, compute, and data objects in 

separate folders, can be restored by enabling the Project View option Group by display/compute/data in tree view in 

the Layout panel of the Preferences. The Models directory has been renamed to Data. 

 

file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/hxspatialgraph/HxSpatialGraph.html%23A1
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NEW XEARTH EXTENSION – GEOPHYSICS EXTENSION 

Avizo Earth edition becomes the XEarth extension, available for Avizo Lite and Avizo.  

The XEarth extension includes dedicated visualization and computation modules and workflows, as well as a SEG-Y 

reader, for the exploration and analysis of geosciences data.  

Same as previous Avizo Earth edition, the XEarth extension requires a specific license. When installing Avizo, a specific 

action is no longer required for installing the XEarth extension: you simply have to enter the appropriate activation 

code in the License Manager dialog. 

A Geophysics profile has been defined to enable all XEarth extension features, which are not available in the default 

profile. To switch to the Geophysics profile, open the General panel of the Preferences and check the corresponding 

checkbox in the Current profile section. 

   

You will then be notified that Avizo must be restarted. After restart you will notice changes in the user interface, 

especially with the dedicated tree view. The profile name is shown in the Avizo title bar. SEG-Y import is now available, 

as well as dedicated modules, colormaps, etc. 
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NEW XGREEN EXTENSION – CLIMATOLOGY EXTENSION 

Avizo Green edition becomes the XGreen extension, available for Avizo Lite and Avizo.  

The XGreen extension includes dedicated visualization and computation modules, a set of geographical projections, 

and a NetCDF reader, for the analysis of climate, oceanography, environmental, and earth-mapped data. 

Same as previous Avizo Green edition, the XGreen extension requires a specific license. When installing Avizo, a 

specific action is no longer required for installing the XGreen extension: you simply have to enter the appropriate 

activation code in the License Manager dialog. 

A Climatology profile has been defined to enable all XGreen extension features, which are not available in the default 

profile. To switch to the Climatology profile, open the General panel of the Preferences and check the corresponding 

checkbox in the Current profile section. 

    

You will then be notified that Avizo must be restarted. After restart the profile name will be shown in the Avizo title 

bar. NetCDF import will be available, as well as dedicated modules, colormaps, etc. 

 

AVIZO LITE AND AVIZO – ENHANCEMENTS AND NEW FEATURES 

USER INTERFACE ENHANCEMENTS 

WORKROOM CONCEPT 

The Avizo 9.0 user interface provides an easier and faster way to switch between application areas. With the user-

friendly workroom concept, several dedicated components are accessible as independent applications assembled 

together into the general Avizo platform. Each component provides its own specific interface, dedicated tools, and 

visualization options. Since switching between different components is possible through a simple toolbar, the user can 

explore and approach complex data sets using dedicated tools in the workrooms, and keep a clear overview in the 

general-purpose framework.  

The following components are currently available as workrooms: 

 Start page 

 Project View  

 Segmentation Editor 

 Filament Editor (requires XFiber extension) 

 Animation Director (new name for the Animation Producer) 
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START PAGE 

When launching Avizo, a Start page now opens, giving you access to shortcuts to improve your user experience: 

 Recent data, recent projects 

 Open Data, Open Project, and Blank Project shortcuts  

 Easy access to help pages, tutorials, webcasts… 

 Latest news regarding Avizo product family and FEI events 

 Community links 

  

The Start page can be disabled but remains available at any time from the Workroom toolbar. 

PROJECT VIEW ENHANCEMENTS 

Avizo 9.0 Project View has undergone several enhancements to improve your user experience: 

 Scrolling is now automatic when dragging icons out of the view. 

 Switching to pan mode is now possible with the [ESC] key or by keeping the middle mouse button pressed. 

 Pressing [H] while a data or a display module is selected will hide all from the 3D viewer except for this data 

or display module. This can also be done from the Project menu or the object pop-up option menu. 
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 Pressing [CTRL] while right-clicking on an object will display the list of favorite items of the object pop-up. A 

simple click on the item of your choice will create it. 

 
 In the object pop-up, the option menu related to a selected object is now more visible and accessible. 

  
 The Project View, Properties area, and Workroom menu are now displayed on the left side of the 3D Viewer 

to improve accessibility and ergonomics.  

 The Project View icons have been redesigned to improve readability. 
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USER INTERFACE SIMPLIFICATION 

The Standard toolbar and Panels toolbar are now hidden by default but can be displayed, as before, by navigating the 

Window menu or the right click menu in the toolbar area.  

 

A shortcut to the Console has been added in the status bar (in the lower right corner of the user interface). The 

Console can also be displayed or hidden using the [Ctrl + Alt + A] shortcut. 

 

AUTOMATIC DISPLAY 

When a new data object is added to Avizo empty Project View, a default display module is now automatically 

connected to it so visualization of the data is immediately available. 

This feature can be enabled, configured, and disabled from the Auto-Display panel in the Preferences. You can choose 

to automatically connect a display module only to newly loaded data objects, or to both newly loaded and computed 

data objects, or only to the first loaded data object. For each data type a display module is recommended by default.  

You can change it as you wish.  
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The automatic display feature can also be easily enabled and disabled from the Project View toolbar dedicated button. 

   

DOCUMENTATION IMPROVEMENTS 

A navigation bar at the top of help pages makes navigation through the Avizo online documentation easier.  

  

The online documentation now only displays by default the contents relating to the licenses that are installed. For 

users who would like to browse all the features of the product including those locked because of missing licenses, this 

setting can be changed in the General panel of the Preferences. 

 

The index generated during the first use of the documentation search tool is now kept on disk, so that it does not 

need to be rebuilt on each restart of the application, making search much faster.  

In a web browser, all Avizo and Amira product family documentation can be accessed by selecting the product of your 

choice in the top left combo box. 

  

This requires a compatible web browser (Internet Explorer or FireFox) with cookies enabled. The web browser may ask 

for a user confirmation about script execution. 
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It is now possible to enable or disable the dockability of the Help panel from the Layout tab of the Preferences dialog.  

GERMAN VERSION OF AVIZO 

A German version of Avizo is now available. You can switch to the German user interface by selecting Deutsch in the 

Language section of the General panel of Preferences. Please note that documentation is still available in English only. 

 

 

NEW IMAGE FORMATS SUPPORTED 

ENHANCED SUPPORT FOR TIFF-BASED FORMATS 

Additional TIFF-based formats are now supported in Avizo. 

Image type/option Avizo 8.1 Avizo 9.0 

Tiff - multiple pages x x 

Tiff – strips x x 

Tiff – tiles  x 

Tiff – grayscale x x 

Tiff – RGB x x 

Tiff - color model YCbCr  x 

Tiff - compression LZW x x 

Tiff - compression jpeg  x 

Tiff - compression deflate  x 

Tiff - images size > 4GB  x 

Zeiss LSM x x 

Metamorph STK x x 

Olympus Fluoview  x x 

x: supported format 

 

NEW AND ENHANCED FEATURES 

NEW MOVE-SENSITIVE EASY PROBE 

A Quick Probe feature, accessible from the viewer toolbar, allows displaying the value and coordinates of a voxel 

using the mouse.  The Quick Probe button supports three modes: move-sensitive, click-sensitive, and disabled. 
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By default, the Quick Probe is move-sensitive i.e., the voxel value and coordinates under the mouse cursor are 

displayed in the progress bar. In click-sensitive mode, the value and coordinates are displayed if the [SHIFT] key is 

pressed and visualization in the viewer is clicked on with the left mouse button.  

NEW REVERSE COLORMAP AND ALPHA CURVE OPTION 

It is now possible to easily reverse the colormap and the alpha curve in the Colormap Editor by selecting the dedicated 

option.  

 

COLORMAP PORT ENHANCEMENTS 

The Edit menu of colormap ports has been slightly reworked.  

It is possible to take into account or not the transparency of a colormap by enabling or disabling the new Transparent 

option. Note that this will have no effect on display modules that already handle transparency another way, such as 

Ortho Slice with its Transparency port, Isosurface with the Draw Style port… An alpha ramp is added to all non-

transparent colormaps at loading time. 
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Adjust range options and zoom options are gathered in the same submenus. The possibility to adjust the range to data 

histogram has been added. 

 

When the mouse hovers over the colorbar: 

 the mouse wheel can be used to zoom on the colorbar, 

 pressing the space bar allows zooming to range and zooming to data min-max alternately. 

The left and right thumbs of the colorbar are snapped when brought close to each other. This is convenient when you 

wish to observe a single label in a label field. 

INTENSITY RANGE PARTITIONING 

The automatic intensity range partitioning supersedes the range calibration feature enabled by default in Avizo Fire 

edition.  

When loading 3D image data, the new automatic intensity range partitioning tool computes a set of values 

representing possible thresholds between phases in the data set based on a gradient method. The set of values (so 

called intensity ranges) are then directly usable in all modules having a threshold value slider port, or colormap port, 

such as Isosurface, Ortho Slice, and Volume Rendering.  

The Preferences Range Calibration has been replaced with tab Range Partitioning that allows control of this feature. 

Range partitioning is disabled by default in Avizo Lite and enabled in Avizo. When enabled, you can choose to define 
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the number of regions that must be computed or let the algorithm detect this number automatically. The data 

window then computed will be used to initialize the colormap range of 3D display modules such as Volume Rendering 

and for intensity-related ports such as threshold segmentation ports. Any other display module colormap range will be 

initialized with the data min-max range unless option Use only for 3D boundaries displays and segmentation 

thresholds is disabled. 

 

SNAPSHOT TOOL ENHANCEMENT 

An antialiasing option has been added in the snapshot tool dialog. 

NEW “SAVE DATA AS” AND “EXPORT DATA AS” POLICY 

The Save Data As command now allows you to save data only in native file formats. A native file format is a file format 

that can save all of the data properties in Avizo. If you want to save your data in a non-native file format, you must 

now use the new dedicated item Export Data As. The file dialog will present a list of all file formats suitable for saving 

that data object, native or not. 

      

   

Save Data As now renames the data object in the Project View according to the saved file name. As a project keeps 

track of the new file associated with the data object, a subsequent Save [Ctrl + S] will update that file and the project 

will refer to that file when saved and reloaded. 

On the other hand, Export Data As keeps the data object name and the project unchanged. 

NEW SAVE PROJECT POLICY 

When saving a project, it is now possible to choose between two options: 

 Minimize the project size: only necessary data objects are saved to disk; data that can be recomputed will be 

recomputed at project loading. This is the legacy behavior. 

 Minimize the project loading time: all the data of the project are saved to disk. This way no computation at 

project loading is necessary. 
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The first time you save a project in Avizo 9.0, the Save Project policy dialog will be displayed, allowing you to choose 

the mode you prefer and to make it the default mode for subsequent projects. 

  

You can modify the default setting at any time from the Save Project section in the General panel of the Preferences. 

 

With the new option Include viewer background settings you can decide to save or not the background color and 

mode in projects. This is disabled by default. 

SCRIPTING ENHANCEMENTS 

A CamelCase label is now registered for all modules, lights, and tree view items. CamelCase labels do not contain 

spaces (words are only separated by capital letters) and may be preferred for convenience when scripting. For 

example, the CamelCase label for Ortho Slice is OrthoSlice.  

For the objects mentioned above, both the GUI labels and the CamelCase labels can be used in the Console (see below 

for auto-completion) and in scripts (GUI labels are saved in saved networks but manually created scripts can use both 

labels).  

The auto-completion in the Console works like this: 

 From an empty console line, if you press the [TAB] key, the label of the selected module in the Project View is 

suggested. It will suggest the shorter of its GUI label and CamelCase label (which is often the CamelCase one). 

If you press the [TAB] key twice or more, it will add quotation marks around the CamelCase label. 

 From few letters:  

o If there is only one possible completion, or if all the suggestions lead to the same object in the 

Project View, the shorter of its GUI label and CamelCase label is enclosed in quotation marks and 

displayed. 

o If there are several possible completions, they are all displayed, mixing GUI labels and CamelCase 

labels. 

NEW LICENSING SYSTEM IMPROVEMENTS 

The reactivation of licenses is now suggested when expired licenses are found and the process automatically 

reactivates all expired licenses. 
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Deactivation of licenses can now be done key by key. 

The FlexNet license server installation and configuration webpage has been updated with many new details, 

examples, simplified commands, and troubleshooting tips. 

Note: Avizo 8.1 introduced a new licensing system, based on on-line activation. Please refer to Avizo 8.1 Release Notes 

for all details (http://www.fei.com/software/avizo-release-notes/). 

NEW OFFLINE LICENSING USER INTERFACE  

A new user interface for the offline activation mode has been added to allow activating licenses on a computer with 

no internet connection.  

This mode is almost the same as the local activation system except that an XML file containing the activation (or 

upgrade, reactivation, return) request is generated instead of processing the request immediately. When selecting this 

offline licensing mode, the different licensing dialogs and wizards are adapted to generate this XML file. This XML 

request file needs to be transferred to a computer with an internet connection. On this computer, you will have to 

open a specific web page in a web browser where you will be able to retrieve an XML response file (containing the 

response to your activation request). You will then have to transfer this XML response file to the computer without 

internet connection and import this file thanks to the new user interface dialogs and wizards. 

OPEN INVENTOR UPGRADE 

Avizo now uses Open Inventor 9.4 as its graphics engine. This upgrade includes bug fixes and improvements such as 

better performance with Delayed transparencies, a new high-performance high quality algorithm for the Sorted Layers 

transparencies, and enhanced Volume Rendering performance for texture generation (non-LDM and compressed 

volumes). 

 

NEW MODULE VOLREN AND COMPARISON WITH VOLUME RENDERING MODULE 

The new Volren module displays a direct full-resolution volume rendering of 3D images with shading effects. Volren 

enables you to render segmented regions at the same time with different colormaps. The Volume Rendering module 

has been developed to take advantage of modern graphics hardware. Volren may provide better performance than 

the Volume Rendering module on old generation graphics hardware.  

http://www.fei.com/software/avizo-release-notes/
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Differences between modules Volren and Volume Rendering 

Feature Volren module Volume Rendering module 

Mouse picking No Yes 

Isosurface Rendering No Yes  
Separate module 

Voxelized Rendering No Yes  
Separate module   

DRR rendering  
(simulated Digitally Reconstructed 
Radiograph) 

Yes No 

MIP rendering  
(Maximum Intensity Projection) 

Yes Yes 

Lighting  and shade effects Yes 
Diffuse, specular 

Yes 
Diffuse, specular, enhanced edge, 
boundary, ambient, deferred, high 

quality 

User-defined light coefficients  Yes No 

Light angle control Yes 
Port Shading: User-defined 

Yes 
Use top menu View>Light 
to Create custom light and 

deactivate Headlight 

Cast shadows  No Yes 

Multi-Channel Field input No Yes 

Color Field input (RGBA) Yes Yes 

Label field secondary input and 
per-label colormap  

Yes No 

Label colormap support  
(cycling, no interpolation) 

No Yes 

Multi-Volume support Yes 
Limitations with intersecting 

volumes and some mode 
combinations 

Yes 
Limitations with some rendering 

options 

Support for data larger than graphics 
memory 

Yes 
Full resolution when still, low 
resolution during  interaction 

Yes 
Progressive adaptive resolution, 

limited by memory threshold 

Support for data larger than the main 
memory (RAM) 

No Yes 
With converting data into LDA 

format 

LDA format support   
(Large Data Access for progressive loading, 
instant preview, quick extract from out-of-
core  data) 

No Yes 

ROI Box (Region of Interest) Yes Yes 

Custom ROI Yes 
Corner Cut  

exclusion corner 

Yes 
ROI Box for Volume Rendering: 

exclusion box, fence, cross, 
subvolume 

Hardware support Modern graphics boards with 
updated driver e.g. NVidia 

Quadro 

Modern graphics boards with 
updated driver e.g. NVidia Quadro 

Requires support for advanced 
shaders 

 



 

20 
Avizo 9.0 release notes – FEI© 2015 

NEW MODULES 

POINT CLOUD FILTER filters a connected Point Cloud by an expression built from the coordinates and data values of 

each Point Cloud (new name for Cluster objects). 

CORNER CUT defines a cutting region with the shape of an axis-aligned 3D box originating from a corner of the 

bounding box. The cutting box can be used to clip the volume displayed by the Volren module. 

EIGENVECTOR TO COLOR, when connected to the first eigenvector of a tensor field and to a vector field 

representing the eigenvalues (both produced by Extract Eigenvalues), generates a color representation that describes 

by a color code the directions of the first principal direction of the tensor field. 

LABEL TO ATTRIBUTE creates a volume filled with label measures contained in a Label Analysis module, based on 

a label image. The output field will have the same dimension as the label image. 

CREATE AUTOMATIC LANDMARKS creates landmarks from a given scalar field. The landmarks’ position is 

determined by the scalar field’s values, the process starting with high values and continuing until the desired number 

of landmarks is reached, keeping a user-defined minimum distance from each other. 

 

ENHANCED MODULES AND EDITORS 

The SIMPLIFICATION EDITOR algorithm has been improved in order to dramatically reduce the occurrence of 

intersections in the computed simplified surface. Topological problems such as flat triangles, flat solid angles (two 

triangles overlapping), extremely close vertices, and flat edges (two triangles sharing an edge and overlapping) are 

now handled in a better way. Normal flipping problems should be avoided in most cases.  

GENERATE SURFACE now supports 32-bit input label fields. The Create Exterior Material option has been renamed 

into Extra Material and allows you to create a pseudo material outside the input lattice, which can be useful to select 

only triangles lying on the boundary face of the bounding box when using Surface View module. The Create All Patches 

option has been added to create the triangles of all patches, including exterior or background regions, which can be 

useful, for example, if the exterior region of the input label field is to be considered during a finite element simulation.  

ILLUMINATED STREAMLINES offers a new coloring mode DEC (Directionally Encoded Colors) that uses red, green, 

and blue primaries to encode the direction of the line segment at a given point where red, green, and blue denote the 

x, y, and z directions respectively.  

ALIGN SURFACES has a new Weights port to assign different importances to the vertices of the surface to be 

transformed. 

ISOCONTOUR ANNOTATED SLICE is deprecated and replaced with an annotate option in the Isocontour Slice display 

module. 

EMBOSSED SLICE is deprecated and replaced with an embossing option in the Slice display module. 

VOLUME EDIT now supports RGBA image inputs. It has a new Padding Value port that specifies by which data 

value(s) voxels in selected regions are replaced when cutting. For color fields a specific value can be set for each 

channel. If a color field is attached to the module, this port allows the user to select if changes should affect only 

the alpha channel or all channels. 

CAPTION, if connected to a data object, will display its name.  

CALCULUS MATLAB supports MATLAB 2014a version (and earlier). 

file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/Word/HxVolren.html%23A1
file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/Word/HxExtractEigenvalues.html%23A1
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PERFORMANCE IMPROVEMENTS 

Several compute modules and image filters have been parallelized, resulting in dramatic performance improvements 

when using multi-core processing (how many cores are used can be controlled in the Performance panel of the 

Preferences dialog): 

 Arithmetic 

 Register Images 

 Resample  

 Laplacian Zero-Crossing 

 Sobel Filter 

 Adaptive Histogram Equalization in 2D only (i.e., XY planes) 

 Lanczos Filter 

 Sigmoid Intensity Remapping 

 Brightness-Contrast 

 Moments Filter 

 Gamma Correction 

Spatial Graph View tube rendering has been improved in speed and responsiveness. Changing the Tube scale factor is 

now instantaneous even for large Spatial Graph objects.  

 

LINUX SUPPORTED DISTRIBUTION 

The official Linux distribution for Avizo is Red Hat Enterprise Linux 6 64-bit. Nevertheless, Avizo is likely to work on 

other 64-bit Linux distributions if the required versions of the system libraries can be found. Technical support for 

those platforms will be limited.  

In order to add custom extensions to Avizo with Avizo XPand, you will need gcc 4.4.x on RHEL 6. 

 

AVIZO - ENHANCEMENTS AND NEW FEATURES 

Avizo Fire now becomes Avizo. 

LABEL ANALYSIS ENHANCEMENTS 

NEW STANDARD SHAPE ANALYSIS MEASURE GROUP 

A new measure group, called Standard Shape Analysis, is available from the Measures drop-down list. This group can 

be used to characterize the shape parameters of labels (such as volume, barycenter, anisotropy, covariance matrix, 

voxel face area…). 

NEW WEIGHTED SHAPE ANALYSIS MEASURE GROUP 

A new measure group, called Weighted Shape Analysis, is available from the Measures drop-down list. This group 

offers measures equivalent to the measures of the Standard Shape Analysis group, but also taking into account the 

gray intensity of an input data. 
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NEW MEASURES 

New XY/3D measures have been added: 

 Majority (most represented gray level intensity inside a particle) 

 Median (median gray level intensity within a particle) 

 GreyBaryCenterZ (Z coordinate of the weighted center of gravity) 

 IntegralMeanCurvature (integral of mean curvature) 

 Anisotropy (region's deviation from a spherical shape) 

 BorderVoxelCount (sum of voxels that are at the intersection of the image volume with its bounding box) 

 EigenVal1, EigenVal2 (largest and medium eigenvalues of the covariance matrix) 

 EigenVec1X, EigenVec1Y, EigenVec2X, EigenVec2Y (X and Y coordinates of the eigenvectors of the covariance 

matrix) 

 Elongation (ratio of the medium and the largest eigenvalue of the covariance matrix) 

 ExtentMin1, ExtentMin2, ExtentMax1, ExtentMax2 (extent of the data in the direction of the eigenvectors of 

the covariance matrix) 

New 3D-only measures have been added: 

 EigenVal3 (smallest eigenvalues of the covariance matrix) 

 EigenVec3X, EigenVec3Y, EigenVec3Z, EigenVec1Z, EigenVec2Z (X, Y, Z coordinates of the smallest eigenvector 

of the covariance matrix and Z coordinates of the other eigenvectors) 

 Flatness (ratio of the smallest and medium eigenvalues of the covariance matrix) 

 VoxelFaceArea (sum of voxel surfaces that are on the outside of each connected component) 

 

NEW MODULES 

LOCAL THRESHOLDING provides algorithms to perform a binary segmentation of an image stack into foreground 

and background objects. The output of the module is a label field. The algorithms work best if multiple small objects 

need to be segmented before a slowly varying background. Local methods adapt the threshold value on each pixel to 

the local image characteristics, as opposed to global (histogram-based) methods (e.g., in Auto Thresholding and 

Interactive Threshold modules). 

BLOCK FACE CORRECTION can be used to correct inter-slice intensity variations that are typically found in block face 

scanning stacks. Using the Segmentation Editor, the user defines regions of foreground and (optionally) background 

voxels on each slice. Block Face Correction generates corrected slices that have been calculated using the mean voxel 

intensity in the labeled regions. 

FILTER BY SPREADSHEET creates a new a label field object from an existing label field, filtered by a spreadsheet. This 

feature is useful, for example, when the spreadsheet output of Shape Analysis is being filtered or as a complement for 

the Analysis Filter. 

AVERAGE VOLUME  computes the per-voxel average of an arbitrary number of 3D image data sets or label fields. 

HIERARCHICAL WATERSHED uses a variant of the watershed transform to segment gray value images into 

meaningful regions. Hierarchical Watershed can also be used to separate objects in a binary segmented image. Rather 

than producing a single segmentation, the algorithm creates a hierarchy of catchment basins so that the user can 

control the level of granularity of the labeled image. However, unlike Marker-Based Watershed, the markers are set to 

local minima and cannot be specified. 

SPREADSHEET TO POINT CLOUD converts a spreadsheet with x, y, z coordinate columns into a Point Cloud object 

(new name for Cluster objects). 

file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/hxfield/HxUniformLabelField3.html%23A1
file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/hxspreadsheet/HxSpreadSheet.html%23A1
file:///C:/Users/sbaillet/AppData/Roaming/Microsoft/Word/HxShapeAnalysis.html%23A1
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POINT CLOUD DENSITY computes the local density of a Point Cloud. The density value is stored as a new data 

column on the result Point Cloud (new name for Cluster objects). The density is defined as the number of points per 

volume of a sphere centered at the point's location. Several algorithms for computing the density are available. 

 

ENHANCED MODULE 

AUTO THRESHOLDING now provides, as new criterion called IsoData, a new iterative global thresholding algorithm 

based on the gray value histogram of the data. 

 

AVIZO XLAB HYDRO EXTENSION - ENHANCEMENTS 

NEW SUPPORTED PLATFORMS 

Avizo XLab Hydro is now supported on Linux and Mac OS X. 

 

OPERATING SYSTEMS 

Avizo 9.0 runs on: 

 Microsoft Windows 7/8 (32-bit and 64-bit). 

 Linux x86 64 (64-bit). Supported 64-bit architecture is Intel64/AMD64 architecture. Supported Linux 

distribution is Red Hat Enterprise Linux 6. 

 Mac OS X 10.7, 10.8, and 10.9 (64-bit). 

In order to add custom extensions to Avizo with Avizo XPand, you will need: 

 Microsoft Visual Studio 2010 (VC++ 2010) and its Service Pack 1 on Windows. Avizo 9.0 will be the last version 

to support Microsoft Visual Studio 2010. 

 gcc 4.4.x on Red Hat Enterprise Linux 6. 

 gcc 4.2.x, provided by the standard Xcode development environment, on Mac OS X. 

 

SOLVED ISSUES 

Avizo 9.0 provides many enhancements and solutions to known problems, including the following: 

AmiraMesh Reader 32841 Surfaces saved in amiraMesh format can be loaded even if the 
filename path contains extended ASCII characters. 

Arithmetic 30120 
30144 

Arithmetic could result in some inconsistent computation when 
simply switching input ports. This has been fixed. 

Axis Connectivity 30693 Computing axis connectivity on some data could result in never 
ending calculation. This has been fixed. 

Calculus Matlab 23059 (5381) A failure occurring on creating one-dimensional array in a Matlab 
script has been fixed. 
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Color Wash 33228 Port Alpha of Label Blending mode has been renamed to 
Transparency to be more consistent with the overlay label vanishing 
with port's value increase. 

Colormap Editor 31253 The Color Editor and Range Editor histogram ranges are now 
correctly synchronized. 

Crop Editor 30610 Resizing the box with the dragger could change the position of the 
dragger in the viewer, preventing correct resize operations. This has 
been fixed. 

DICOM Reader 23279 (5601) Loading DICOM file containing attribute Icon Image Sequence could 
fail. This has been fixed. 

Extract Subvolume 31362 A subvolume that exceeds 4 GB can be extracted now. 

Filter Sandbox 
 

29649 The Bilateral filter could fail for some data; it has been fixed. 

33835 The preview box has been fixed for data whose origin has negative 
coordinates. 

Generate Surface  
 

33893 Material names associated with the input label field are no longer 
deleted. 

23074 (5396) This module no longer modifies its input data at computation. 

Illuminated Streamlines 
 

32282 When saving and reloading a project file, the parameters of port 
Display Box are no longer ignored and the streamlines are correctly 
displayed. 

22984 (5306) Display Box behavior when projection is activated has been fixed. 

Installer 23726 Silent installation of product must have TASK option set at the end of 
command (e.g. Avizo-900-Windows64-VC10.exe /VERYSILENT 
/SUPPRESSMSGBOXES /NORESTART /NOCANCEL 
/TASKS=edition_standard). Task value can be edition_standard or 
edition_standard,edition_lite. 

Interactive Thresholding 
 
 

23252 (5574) Interactive Thresholding now replaces its result at recomputation 
instead of creating a new one. 

34074 The Intensity Range (formerly called Threshold) value is now saved in 
project file and reloaded correctly. 

31263 The Preview Slice Number port is now updated when interacting with 
the slice in the Viewer. 

Interactive Top-Hat 23757 The preview could be corrupted when a transformation had been 
applied to the input data. This has been fixed. 

Isosurface 
 

32180 Errors at loading project containing Isosurfaces with sorted layers 
delayed transparency have been fixed. 

31132 [Mac OS X] Computation of Isosurface could fail on Mac OS X. This 
has been fixed. 

Label Analysis  
 
 
 

23812 AreaFraction measure now returns values between 0 and 1. 

33310 Breadth3D measure error occuring with input data with minimum 
coordinate different from (0,0,0) has been fixed. 
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23612 Distance measure could sometimes result in errors in the Console 
and Avizo failure. This has been fixed. 

31590 Quantile values can be modified independently. 

23954 The Label Seek (formerly called Label Tracking) has been fixed to 
display the right correspondence between the probe and the label. 

24058 Transformation of the input data is now applied to the result data. 

28617 FirstPoint measure has been fixed. 

LDA  23839 The display of 2D RGBA LDA files has been fixed. 

LDA Converter 31801 2D TIFF files can be converted to LDA without errors. 

Libraries 23671 [Linux] The start script of Avizo on Linux detects system libraries, 
identifies missing ones, and adds compatibility libraries (provided in 
a compatibility folder) in the path if necessary. 

Measurement 29934 The box tool can now be applied to color fields. 

Median Filter 22642 (4964) Median filter has a new port to specify the 3D neighborhood. 

Movie Maker 21116 (3435) Volume Rendering could appear incomplete or jerky in generated 
movies. This has been fixed. 

Ortho Views 23764 Slice clipping is supported on Intel HD and Radeon HD graphic cards. 

Resample Transformed 
Image 

32275 Nearest Neighbor interpolation now works correctly when applied to 
a label field. 

ROI Box 33544 ROI Box is now correctly applied to Slice modules when connected to 
their ROI port. 

Save/Export 31287 An error message is now displayed in the Console when 
saving/exporting a data object fails, e.g., due to a lack of space on 
disk. 

Segmentation Editor 
 
 
 

30568 It is now possible to take a snapshot of all four viewers at a time. 

22969 (5291) Performance issue when using both 3D view and brush tool has been 
fixed. 

30597 The [S] hot key has been fixed to subtract the selection from the 
material. 

23796 The update of the colormap in Zoom and Data Window is now 
correctly taken into account. 

Shading Correction 
Wizard 

30281 Connection between the threshold slice and the main slice has been 
restored. 

Spatial Graph View  
 

32114 
32571 

A failure has been fixed when displaying segments as tubes and 
changing selection of ports Tube Scale or Segment Coloring. 

20353 (2670) The connection to the spreadsheet result of Spatial Graph Statistics 
has been fixed and can be used for highlighting again. 

Start Avizo 31665 The beta version of Avizo 9.0 could take up to several minutes to 
start. This is back to normal in this release version. 
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Surface 31119 When reloading a saved surface, changing the color of any material is 
now possible and taken into account. 

Volume Rendering 
 
 
 

23105 (5427) 
23106 (5428) 

Inversion of data values and/or colormap bounds is now correctly 
taken into account and display updated accordingly. 

22320 (4642) 32-bit label fields are now supported. 

23133 (5455) Rendering issues with AMD Radeon HD graphic card have been fixed. 

23052 (5374) Label field rendering is consistent when switching between quality 
levels. 

20855 (3173) Volume Rendering could display wrong colors for label fields. This has 
been fixed.  

Voxelized Rendering 32874 Voxelized Rendering could display wrong colors. This has been fixed. 

Watershed Segmentation  31274 The computed Gradient Magnitude is removed from the project view 
when going back to previous steps, avoiding data duplication. 

 

Our team permanently focuses on solving as many issues as possible to make your experience of Avizo as satisfactory 

as possible. To this purpose, we would appreciate your feedback regarding this version. If you encounter problems, or 

if you have suggestions for improvement, please report them to vsghotline@fei.com. 
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